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Introduction 

The purpose of this document is to describe how to use the tools in SiteViz Premier to create WCAG 

compliant content. WCAG stands for Web Content Accessibility Guidelines. The current version, WCAG 

2.0, is considered the international standard for website accessibility.  

WCAG compliance is important because many online visitors may have disabilities that prevent them 

from accessing some of the content on your site. For example: 

Users with vision impairment may have trouble reading text and noticing differences between colors. 

They may rely on assistive technologies such as a screen reader, magnifier, or braille display to navigate 

and understand your website. 

Users with hearing impairment may not be able to hear the audio portions of media embedded on your 

pages. They may rely on captioning technology or a braille display. 

Users without fine motor skills may be unable to use a mouse and may instead rely on a keyboard to 

navigate content. 

The WCAG establishes best practices that ensure online content can be accessed by people with 

disabilities. 

This document covers scenarios commonly encountered when managing website content that often 

result in accessibility problems. It is specifically meant to address the WCAG 2.0, levels A and AA 

requirements that pertain to websites. While this document attempts to be thorough, it is not intended 

to be a replacement for the actual WCAG guidelines and may not cover all possible content scenarios. 

It is recommended that you familiarize yourself with the underlying guidelines found here: 

http://www.w3.org/WAI/intro/wcag. 

This document assumes prior working knowledge of the SiteViz Premier administrative environment. If 

any steps are not clear, please contact your Global Reach account representative for further 

clarification or training. 

Proprietary Notice 

The document, and the contents within, are confidential and proprietary to Global Reach. It may not 

be disclosed to any third party without the express written permission of Global Reach.  

http://www.w3.org/WAI/intro/wcag
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Content Layout 

Copying and Pasting Content 

Guideline1.4.4 Resize Text – Level AA: Except for captions and images of text, text can be resized 

without assistive technology up to 200 percent without loss of content or functionality. This success 

criterion helps people with low vision by letting them increase the text size of content so that they can 

read it. 

The method by which you add content to your website has a major impact on creating and 

maintaining an accessible site.  

Whenever content is copied from another source such as a Word document or another website, it is 

very important to first paste it into Notepad before pasting it into the SiteViz website editor. This step 

ensures that the text does not inadvertently transfer any extraneous HTML formatting attributes that 

could affect the accessibility of the content. In addition, pasting text straight from another source will 

cause inconsistencies in the appearance of text throughout your website, which looks unprofessional. 

The following error may occur if content is copied and pasted from other sources without first pasting it 

into Notepad: “Use relative rather than absolute units in FONT SIZE attributes.” This error indicates that 

there is text on the page that a user will not be able to resize using their browser because the font is 

using a fixed unit of measurement such as points or pixels instead of relative units of measurement such 

as ems or rems. 

Content that has not been pasted into Notepad may look something like this when viewed in the 

Source view of the website editor, with attributes inside <span> tags:  

 

Even if you click the “Remove Format” button in the website editor, styling inside <span> tags will 

remain. 
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Headings 

Guideline 1.3.1 Info and Relationships – Level A: Information, structure, and relationships conveyed 

through presentation can be programmatically determined or are available in text.  

Guideline 1.3.2 Meaningful Sequence – Level A: When the sequence in which content is presented 

affects its meaning, a correct reading sequence can be programmatically determined. 

When a page contains several logical sections, you should label each section using a heading. 

Headings give your content structure and identify important sections within it. When you add a 

heading, the system inserts a special code into the content that can be read by assistive technologies 

as well as search engines. 

Here are some guidelines to follow when adding headings: 

• Use headings that are descriptive of the content underneath them. 

• Avoid using headings simply for styling text. 

• Avoid the use of Heading 1 for headings other than the page title, because using it for multiple 

headlines on a page may create search engine optimization (SEO) problems. 

• Follow proper nesting order. This means that a subheading should use the heading number that 

is one greater than the heading of the section containing it. For example, a poor nesting order 

might look like this: 

Heading 2 

 Heading 4 

 Heading 5 

Heading 1 

 Heading 3 

In the scenario above, Headings 4 and 5 are being used under a Heading 2. The proper 

approach would be to make these Heading 3 instead. The Heading 1 is being used and listed 

later in the page than other headings. The proper way to use headings in this scenario is as 

follows: 

 Heading 2 

  Heading 3 

  Heading 3 

 Heading 2 

  Heading 3  
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Instructions 

To add headings to your content, follow these instructions: 

1. Highlight the text that should be converted into a heading: 

 
 

 

2. In the top left menu of the toolbar select the heading that is desired: 
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Multi-Column Content 

When laying out content on a page, use a single column rather than two. If an additional column is 

needed for secondary content, use the features built into SiteViz for adding sidebar content. This will 

provide a better keyboard navigation experience than if the content is positioned manually using the 

content editor. 

Three types of sidebar content are supported for static pages: 

• Links – Create a list of hyperlinks to other pages on your site or on other sites 

• Documents – Create a list of documents that are related to the content of the page 

• Content Boxes – Create a box of textual content or images using an editor 

Instructions 

To add sidebar content for a static page, follow these instructions: 

1. Go to the page management area in SiteViz and edit the page: 

 

 

 

2. Determine which type of sidebar content you wish to add and click the appropriate tab: 
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3. After adding the content under one of these tabs return to the “General” tab: 

 

 

4. At the bottom of the “General” tab click the “Save and Publish” button: 
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Long Pages 

Guideline 2.4.5 Multiple Ways – Level AA: More than one way is available to locate a Web page within 

a set of Web pages except where the Web Page is the result of, or a step in, a process. 

• G64: Providing a Table of Contents - A table of contents provides links to sections and 

subsections of the same document. Those sections could be located on the same Web page or 

spread across multiple Web pages. 

If you have a lot of content on a page it may be time consuming for users with assistive technologies to 

scan the page to find what they are looking for. Although not required for Level A and AA, the 

recommended way to make these pages easier to navigate is to include headings for each section of 

the page. Assistive technology can provide the user with a list of all headings and let them jump to the 

one that they are interested in. 

However, if headings cannot be added because the content is not hierarchical then it is 

recommended to add a table of contents to the top of long pages. 

Instructions 

To add a table of contents, follow these instructions: 

1. At the top of the page create a paragraph that resembles a table of contents, as shown in the 

image below. The exact wording and formatting is not important but you should try to keep 

consistency between pages and make the table meaningful and easy to read.  

 

2. Place your cursor at the start of a content section then click the flag icon in the toolbar (also 

called the “Anchor” tool).  
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3. You will be asked to give the anchor a name. This name is not going to be visible on the page, 

but will be visible in the browser’s address bar. Good anchor names are short, meaningful, and 

do not contain special characters or spaces. 

 

4. Once you have added anchors to the relevant sections, scroll back to the top of the page. 

Highlight the appropriate text in the table of contents, then click the “link” icon in the toolbar. 

 

5. Now you will be presented with the “Link” window. Change the Link Type to “Anchor in this 

page”, then select the relevant anchor from the dropdown provided. Then click the green “OK” 

button at the bottom of the window. 
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6. Repeat the steps above until all the links in the table of contents have been created, then save 

the page. 
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Lists of Items 

Guideline 1.3.1 Info and Relationships – Level A: Information, structure, and relationships conveyed 

through presentation can be programmatically determined or are available in text. 

When listing items on a page, use the bulleted or numbered list buttons in the toolbar instead of simply 

putting each item on a new line. Defining lists with the buttons in the toolbar will add special code to 

the page that can be read by assistive technologies and help users navigate the content quicker. 

Instructions 

To add a list, follow these instructions: 

1. Create the list of items, one on each line:  

 

2. Highlight all of the items that belong in the list, then click one of the list icons in the toolbar: 
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3. The items should be converted into a list as shown below: 
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Tables 

 

Tabular Data 

Guideline 1.3.1 Info and Relationships – Level A: Information, structure, and relationships conveyed 

through presentation can be programmatically determined or are available in text.  

Guideline 1.3.2 Meaningful Sequence – Level A: When the sequence in which content is presented 

affects its meaning, a correct reading sequence can be programmatically determined. 

For accessibility, tables should ideally only be used for tabular data and not for laying out non-tabular 

content on a page such as photos and text. The reason for this is that when assistive technologies 

encounter a table, they will try to understand it as a collection of rows and columns which are related 

to each other. If you use tables as a layout tool without adding a special attribute in the source code, it 

will impair the ability of assistive technologies to interpret the content on the page, and it may also 

interfere with the responsiveness of your website. Using tables to display content may also cause issues 

with the responsiveness of the page. For more information, please refer to the Responsive Content Entry 

Guide found here: https://www.globalreach.com/support/tips-and-tricks  

Note: When entering tabular data, do not use multiple spaces or the keyboard tab key to align 

elements, use the method described below.  

Instructions for Tabular Data 

To create a table, follow these instructions: 

1. Place the cursor at the point where you want to add the table, then click the table icon in the 

toolbar: 

 
 

https://www.globalreach.com/support/tips-and-tricks
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2. You will be presented with a window containing the table options. 

 

Here are some hints for how to configure the table. 

 

• Specify the number of rows and columns, making sure to include an additional row for the 

column headings. You can always add more rows or columns later if needed. 

 

• Leave the width field empty to make the table only take up the space it needs, otherwise set 

it to 100% so that the table will stretch to the width of the page. Do not use a fixed width like 

“500” as this will prevent the table from growing and shrinking for users with different sized 

screens. 

 

• Choose the “Headers” option that best suits your needs. It is recommended that you use row 

headers, column headers or both. If First Row is selected, then the first row in the table must 

be used for column headers. If First Column is selected then the first column must be used for 

the row headers. Row and column headers should be short and descriptive of the contents 

within that row or column. Using row and column headers allows assistive technology to 

better understand the table’s data and present it to the user in an easy to navigate way. 

 

• The border size may be set to “0” if no border is needed to easily read the table. However, if the 

table is very long or wide then adding a border can assist users with skimming it. Depending on 

the content in your data table, you may find it beneficial to use one or more of the responsive 

stylesheet classes described later in this section. 

 

• Summary content is not shown to users and is not compatible with the latest version of HTML, 

therefore we recommend avoiding the use of this field. 
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The following is an example configuration: 

 

 

3. After the table has been added, fill in the cells: 
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Table Headings That Span Multiple Columns or Rows 

Some tables require headings that span multiple columns or rows. To achieve this, do the following: 

1. Create the basic table using the instructions in the previous section. 

 
 

For our example, this is the result:  

 

 

 

2. Click in the cell you want to modify, then right click and select Cell>Cell Properties from the pop-

up menu. Set the Cell Type to "Header" (if not already selected). If the header will span multiple 

columns or rows, enter the number in the appropriate Span field: 
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1. The setting above results in a table that looks like this: 

 

 

2. Don’t be alarmed! This is to be expected. Simply click in the extra cell(s) you no longer want, 

then right click and select Cell>Delete Cells. Now it looks like this: 

 

Setting Column Headers 

If your table needs column headers, you will need to define them as a header, otherwise, they will look 

like the rest of the data and screen readers will not interpret them as headers:  

 

1. To define Column headers, click in the cell you want to modify, then right click and select 

Cell>Cell Properties from the pop-up menu. Set the Cell Type to "Header.” Do this for each cell 

that needs to be a column header. The result will look like this: 
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2. If a column header or row header needs to span more than one column or row, the process is 

the same as for table headers that span multiple columns. Click in the cell you want to modify, 

then right click and select Cell>Cell Properties from the pop-up menu. Enter the number of 

columns or rows being spanned in the appropriate Span field. Delete any cells you no longer 

need. 

 

Styling Data Tables 

Additional table styling options are available through the stylesheet class settings in SiteViz. The 

Stylesheet Classes field can be found on the “Advanced” tab of the Table Properties dialog box.  

These styling methods are not directly related to accessibility but can be very helpful for general 

appearance and professionalism. Applying these classes will add styling that coordinates with the look 

of your website and will respond nicely on various devices (assuming your website has been developed 

to be responsive). The class names are “styled”, “styled striped” and “tablesaw”. 

Styled – The “styled” class gives the table a professional look that is customized to the look of your 

website: 
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Styled Striped – The “styled striped” class adds alternating row colors to your table. This is especially 

helpful for tables with several rows of data that may otherwise become difficult to read.  

 

 

Tablesaw – Some tables contain many columns of data. On smaller screens, the columns can become 

so narrow that the information is cramped and the overall presentation suffers. In those situations, we 

recommend using the “tablesaw” class. On screens that are narrower than 640px wide, it will stack the 

data into a two-column layout with the column headers on the left and the data on the right. 

 

 

This is a table with the tablesaw class in normal view: 
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This is the table with the tablesaw class on a smaller screen: 
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Instructions for Responsive Data Tables 

To create a responsive table, follow these instructions: 

1. If you are creating a new table, click on the Table tool in the toolbar:  

 

If you are editing an existing table, right click on the table and select “Table Properties” from the 

menu list: 

 

2. Click on the “Advanced” tab and in the Stylesheet Classes field enter the class names you want 

depending on the needs of your table (styled, styled striped, or styled striped tablesaw). 

The following is an example configuration: 

 

3. Click “OK” to close the properties box and click “Save” or “Save and Publish” to save the page. 
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Non-Tabular Data: Using Tables for Layouts 

Although tables are strongly discouraged for non-tabular data, if the page content cannot be simplified for 

some reason and you must use tables for visual layout, different steps must be followed: 

1. The table needs to be coded as a responsive table,  

2. A “role” attribute must be added to the table’s source code to let screen readers know it is not a 

data table. 

Step 1: Create a Responsive Layout Table 

To make a table responsive, follow similar steps as above, with a few changes:  

• Specify the number of rows and columns. 

• Leave the width field empty 

• Do not select any “Header” rows.  

• The border size should be set to “0” if no border is needed.  

• Summary and caption content should be left blank. 

• Go to the “Advanced” tab and add responsive under “Stylesheet Classes” 

The following is an example configuration: 
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The key thing to keep in mind when using tables for layout is that only one cell should be used for all of 

the content that you want to appear in that area. Do not separate related content into several rows. If 

you do, when the table is reformatted for mobile, the content will be out of sequence. See the 

diagrams below to get a clearer understanding of this concept. 

Desktop Layout Table:  

 

Mobile/Tablet Layout Table: 

 

Therefore, if you want to have several lines of text arranged in a particular way, instead of this layout 

with six separate cells:  
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You should use this layout, with only two cells: 

 

So that on mobile, it will look like this:  

 



 

 

26 • GLOBAL REACH INTERNET PRODUCTIONS, LLC CONFIDENTIAL 

Step 2: Add the Role Attribute to the Layout Table 

Once you have your table set up with non-tabular elements, you must add the “presentation” role 

attribute to the table. This will ensure that screen readers understand that the table should not be 

treated as data.  

1. To do this, enter the Source view: 

 

2. Find the table attribute line in the HTML, which should look something like this:  

 

3. After the word table add the following: role=”presentation” so that it looks like this: 

 

4. Save, or Save and Publish the page.  
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Styling Content 

Guideline 1.4.1 Use of Color – Level A: Color is not used as the only visual means of conveying 

information, indicating an action, prompting a response, or distinguishing a visual element.  

Guideline 1.4.3 Contrast (Minimum) – Level AA: The visual presentation of text and images of text has a 

contrast ratio of at least 4.5:1, except for the following: 

• Large Text: Large-scale text and images of large-scale text have a contrast ratio of at least 3:1; 

• Incidental: Text or images of text that are part of an inactive user interface component, that are 

pure decoration, that are not visible to anyone, or that are part of a picture that contains 

significant other visual content, have no contrast requirement. 

• Logotypes: Text that is part of a logo or brand name has no minimum contrast requirement.  

Some users are unable to see color differences when the contrast between them is low. When applying 

styles meant to differentiate a piece of content from its surroundings, make sure color is not the only 

property of the style that is different. Other methods of distinguishing content are: 

• The font weight, for example making the text bold 

• Changing font family  

• Changing the font size 

• Italicizing  

• Underlining (recommended only for linking text) 

• Changing spacing or indentation 

• Adding a background color when the adjoining content has none 

• Adding a border 

For example, the following text uses only color to distinguish the link from normal text: 

 “We are always looking for talented team players. See our current career openings.” 

A user with color blindness or other vision impairment may have trouble knowing that the last three words 

were a link. Adding an underline to this link makes it more distinguishable from the surrounding text.  

 “We are always looking for talented team players. See our current career openings.” 

SiteViz applies appropriate styles to links and headings automatically, so if Global Reach designed your 

website to be WCAG compliant you do not need to do anything special with these styles. However, if 

your content contains features such as content labels that are not important enough to be headings, or 

text that is intended draw attention, you may need to manually apply styles.  

  



 

 

28 • GLOBAL REACH INTERNET PRODUCTIONS, LLC CONFIDENTIAL 

Instructions for Creating Custom Styles 

Simple styles such as bold and italics may be applied using the tools in the content editor. If you need 

more complex styles that can be shared between pages then follow these instructions: 

1. In SiteViz navigate to Manage Websites -> Website Styles, then click the “Add New Website 

Style” in the top right corner: 

 

 

2. Here are some hints on how to fill out the styles form: 

• Choose a name that makes sense to you and is short, but descriptive. This name is not shown 

to users on your website. 

• Leave the CSS Class field as it is when automatically filled out. This field can be used in 

advanced situations with guidance from a Global Reach team member to resolve style 

problems or to link up with an existing system style, so in almost all cases it does not need to 

change. 

• You do not need to fill out all of the fields on the page. Leave fields blank if you do not need 

to change that property. While the goal is to differentiate text, changing too many 

properties can cause the text to become visually unappealing and may create readability 

problems. 

• The Style Type setting can be used as follows: 

o Normal – The styled text will stay in the same line as any un-styled text next to it. 

o Banner – The styled text will be applied to all of the text in the same block, and all of 

that text will be horizontally centered. 

o Paragraph – This is similar to the Banner type, however additional paragraph margins 

are added around the styled block.  

• As you fill out the form, you will see a preview at the bottom that shows what text will look like 

with that style applied. 

• At the bottom of the page, check the boxes next to the website(s) that the style may be 

used on. 
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The following shows an example configuration: 

 

3. After the style has been saved, navigate to the area of SiteViz where the style needs to be 

applied. 

 

4. Highlight the text that needs to be styled: 
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5. Go to the styles menu in the top left corner of the toolbar and select the desired style: 

 

6. The style will now be applied to the text as shown below: 
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Determining Acceptable Color Contrast 

If you select a color to add emphasis to text that was not pulled from the original WCAG-compliant 

design, you need to verify that the contrast between the text and the background meets Level AA 

requirements. Two useful tools are Colour Contrast Analyser and Tanaguru Contrast Finder.  

Colour Contrast Analyser (CCA) is available for Windows and Mac and can be downloaded at 

https://www.paciellogroup.com/resources/contrastanalyser. With CCA, you simply use the eyedropper 

tool to sample the color on the web page. Alternatively, you can type in the 6-digit hexadecimal color 

value (“hex color”), as shown below.  

 

The Tanaguru Contrast Finder, shown below, is a browser-based tool that checks foreground and 

background contrast and can be found at http://contrast-finder.tanaguru.com.  If your color does not 

have sufficient contrast, the Contrast Finder supplies a list of the nearest colors that conform to WCAG 

standards. With this tool, you will need to know the RGB or Hex values in order to use it.  

 

https://www.paciellogroup.com/resources/contrastanalyser
http://contrast-finder.tanaguru.com/
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If you don’t know what the RGB or Hex value is for the color you’ve selected, you may find these 

resources helpful: 

• Pantone to Hexadecimal: https://www.pantone.com/color-finder - Enter your Pantone number, 

click on the swatch and a new page will provide you with the RGB and Hex values. 

• Eye Dropper Chrome Extension https://chrome.google.com/webstore/detail/eye-

dropper/hmdcmlfkchdmnmnmheododdhjedfccka - is an open source extension that allows you 

to pick colors from web pages, color picker and your personal color history. 

• HTML Color Picker http://htmlcolorcodes.com/color-picker  

 

  

https://www.pantone.com/color-finder
https://chrome.google.com/webstore/detail/eye-dropper/hmdcmlfkchdmnmnmheododdhjedfccka
https://chrome.google.com/webstore/detail/eye-dropper/hmdcmlfkchdmnmnmheododdhjedfccka
http://htmlcolorcodes.com/color-picker
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Copy Writing 

Page Titles 

Guideline 2.4.2 Page Titled – Level A: Web pages have titles that describe topic or purpose. 

Ensure that the page title and window title adequately describe the contents of the page. Titles should 

not be so long that they are difficult to read, and not so short as to be unhelpful for identifying the page 

contents. 

The window title is often announced by assistive technology when the user switches between tabs or 

visits a page for the first time. 

The page title is encountered if the user browses the content page or browses the list of all headings on 

the page.  

Uncommon Words and Conventions 

Guideline 3.1.4 Abbreviations – Level AA: A mechanism for identifying the expanded form or meaning 

of abbreviations is available. 

Some assistive technologies can make uncommon words unintelligible. For example: 

• Abbreviations 

• Industry jargon 

• Acronyms 

• Brand or product names 

Some writing conventions may also prove difficult for assistive technologies to deal with. For example: 

• Words written in all caps 

• Numbers without prefixes or suffixes 

• Ranges of numbers 

• Improper use of punctuation 

Consider making content easier to read by using common words and writing conventions. If a word 

may be difficult for a user to understand when mispronounced consider including or linking to a 

description. 
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The following are examples of common problems and solutions: 

Problematic Text 2321 N. Loop Dr. Ste 101 

Solution 2321 North Loop Drive, Suite 101 

Explanation The letter “N” followed by a period may cause a screen reader to announce 

the letter “N”, pause as though it were at the end of a sentence, and then 

proceed on. This lack of fluidity may prevent the reader from understanding 

that the preceding and subsequent text belongs together. 

The abbreviations “Dr” and “Ste” may be announced as “Doctor” and “Saint” 

even though they are intended to be “Drive” and “Suite”. 

 

Problematic Text AMES IA 50010 

Solution Ames, Iowa 50010 

Explanation If the assistive technology did not recognize the name “AMES” as a word it may 

treat it as an acronym. Making it lower case shows the intent that it should be 

read as a word. 

The abbreviation “IA” will likely be read as “I.A.” by assistive technology. 

Depending on context this may or may not be a problem. If the user reading 

the content does not know that “Ames” is a city in the state of “Iowa”, they 

may not understand that “Ames I.A.” is a location. Spelling out the full state 

name ensures it is announced properly. Adding commas will let the assistive 

technology pause in between words to signal that they are separate entities. 
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Problematic Text THIS ITEM IS OUT OF STOCK – New orders will be processed in Feb 

Solution This item is out of stock – New orders will be processed in February. 

Explanation The capitalized words may be announced as acronyms. Making them 

lowercase prevents this problem. Consider using styles such as bold or italic text 

to draw attention to important content. 

The word “Feb” may not be understood by assistive technology as an 

abbreviation. It is safer to use the full word “February”. 

 

Problematic Text The application fee is 5.00 for students 12.00 for adults 

Solution The application fee is: $5 for students, $12 for adults 

Explanation Without punctuation a screen reader will read the entire sentence without 

pausing. Adding a colon and comma allows pauses to be inserted where 

appropriate. 

The number 5.00 will be read by screen readers as “five point zero zero”. Since 

the numbers are intended to represent money, and since the additional 

precision is not necessary in this case, it is best to just remove them. 

 

Problematic Text Today we are open from 8 - 12. 

Solution Today we are open from 8:00 to 12:00. 

Explanation Some screen readers may not read the hyphen and will pause instead. Using 

the word “to” helps ensure the numbers are understood to be a range. 

 

Adding the colon allows assistive technology to understand that the numbers 

are referring to a time since this is a very common convention. For example, a 

screen reader may read “8:00” as “Eight o’clock”. 
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Problematic Text Global Reach won the Prometheus Award. 

Solution Global Reach won the Prometheus Award for creating an innovative web 

technology. 

Explanation The word “Prometheus” is not common and may be difficult to understand 

when read by a screen reader.  Including some extra text helps the user 

understand what is being referred to. 

 

Adding a link to a page containing more information is also a good idea. 

 

Problematic Text You are invited to attend 

our 30th anniversary 

celebration! 

Come join us for cake, 

ice cream, and loads of 

fun for the whole family! 

Solution You are invited to attend our 30th anniversary celebration! 

Come join us for cake, ice cream, and loads of fun for the whole family! 

Explanation Centrally aligned text is more difficult for users to scan. While it is generally not 

harmful in small amounts, for example within a headline, it should generally be 

avoided for longer paragraphs. 
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Problematic Text You are invited to attend  our  

30th  anniversary celebration! 

Come  join  us   for  cake, ice  

cream, and  loads  of  fun  for 

the  whole  family   to   enjoy! 

Solution You are invited to attend our 30th anniversary celebration! 

Come join us for cake, ice cream, and loads of fun for the whole family to 

enjoy! 

Explanation Fully justified text is more difficult for some users to read and should be avoided. 

 

Different Languages 

Guideline 3.1.2 Language of Parts – Level AA: The human language of each passage or phrase in the 

content can be programmatically determined except for proper names, technical terms, words of 

indeterminate language, and words or phrases that have become part of the vernacular of the 

immediately surrounding text. 

If a webpage has a passage of text in a different language, add the “lang” attribute within the page 

HTML by clicking on “Source” in the content editor. An example is shown below.  A list of language 

codes can be found on the W3Schools Website at 

https://www.w3schools.com/tags/ref_language_codes.asp   

<p>It is polite to welcome people in their own language:</p> 

<ul> 

    <li lang="zh-Hans">欢迎</li> 

    <li lang="zh-Hant">歡迎</li> 

    <li lang="el">Καλοσωρίσατε</li> 

    <li lang="ar"> سهلا اهلا و </li> 

    <li lang="ru">Добро пожаловать</li> 

    <li lang="din">Kudual</li> 

</ul> 

  

https://www.w3schools.com/tags/ref_language_codes.asp
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Physical References 

Guideline 1.3.3 Sensory Characteristics – Level A: Instructions provided for understanding and operating 

content do not rely solely on sensory characteristics of components such as shape, size, visual location, 

orientation, or sound. 

Since some users are unable to see the physical layout of your website it is a good idea not to rely on 

references to physical locations or properties of the site. 

For example: 

“Click on the red link in the right column for more information.” 

For a user who cannot see the screen there is not enough information to follow these instructions. This 

sentence could be improved as follows: 

 “Find out more information About Our Product.” 

This provides a link that the user can click on to immediately find out the recommended information.  

Linking Text 

Guideline 2.4.4 Link Purpose (In Context) – Level A: The purpose of each link can be determined from 

the link text alone or from the link text together with its programmatically determined link context, 

except where the purpose of the link would be ambiguous to users in general. 

To navigate the page quickly, a user with assistive technology may only read the links on a page. These 

links may be presented in a list and separated from their surrounding text. For this reason, it is helpful to 

make the linking text descriptive so it can be better understood when the link is presented by itself. It is 

also recommended to avoid having duplicate linking text on the same page to prevent ambiguity. 

For example: 

 “Our solutions are great. To read more about our services click here” 

This example can be improved by making the linking text more descriptive: 

 “Our solutions are great. Read more about our services.” 

Media 

Images 

Guideline 1.1.1 Non-text Content – Level A: All non-text content that is presented to the user has a text 

alternative that serves the equivalent purpose, except for the situations listed below. 
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• Controls, Input: If non-text content is a control or accepts user input, then it has a name that 

describes its purpose. (Refer to Guideline 4.1 for additional requirements for controls and content 

that accepts user input.) 

• Time-Based Media: If non-text content is time-based media, then text alternatives at least 

provide descriptive identification of the non-text content. (Refer to Guideline 1.2 for additional 

requirements for media.) 

• Test: If non-text content is a test or exercise that would be invalid if presented in text, then text 

alternatives at least provide descriptive identification of the non-text content. 

• Sensory: If non-text content is primarily intended to create a specific sensory experience, then 

text alternatives at least provide descriptive identification of the non-text content. 

• CAPTCHA: If the purpose of non-text content is to confirm that content is being accessed by a 

person rather than a computer, then text alternatives that identify and describe the purpose of 

the non-text content are provided, and alternative forms of CAPTCHA using output modes for 

different types of sensory perception are provided to accommodate different disabilities. 

• Decoration, Formatting, Invisible: If non-text content is pure decoration, is used only for visual 

formatting, or is not presented to users, then it is implemented in a way that it can be ignored by 

assistive technology. 

Whenever possible, use actual text instead of images of text. 

If images with embedded text are used, they should also include alternative text (referred to as “alt 

text”). The alt text should tell the user as much as possible about the image in as few words as possible. 

Use less than 120 characters when writing alt text as more than that may be ignored by accessibility 

tools. If more explanation is needed, the alt text should indicate how the user can get to it. For example, 

"Click this image to learn more about our special deals". 

Decorative images used solely for an aesthetic effect should not have alt text assigned.  Images without 

alt text will be ignored by assistive technology. In addition, do not add meaningless alt text, such as "this 

is a placeholder.” It will only frustrate users and will slow down assistive devices that convert text to 

speech or braille output. 

Most places in SiteViz that allow for an image upload also have a field for the image’s alt text. The 

following instructions describe how to add alt text to images embedded via the content editor:  

1. Navigate to the content which contains the image. In the example below the text is part of the 

image because it contains an unusual font and style that cannot be easily replicated with real 

text. 
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2. Click the “OK” button at the bottom of the window to apply the change. 
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PDF Files 

PDF files used on your website should be accessible to users with disabilities. These files often present 

challenges due to the way they are created and the complex content they often contain. Some files 

are created from a scanned document and may only contain images, lacking text for screen readers 

to process. Others may have very complicated layouts and lack a clear content hierarchy for users to 

navigate.  

For the best results, it is recommended that PDF files are created and edited with Adobe Acrobat Pro 

version DC or later. Authors should familiarize themselves with Adobe’s guides for creating accessible 

PDFs: https://helpx.adobe.com/acrobat/using/creating-accessible-pdfs.html. It is highly recommended 

that the author use the accessibility report included in Acrobat Pro DC to identify and resolve problems 

before publishing the file to the web. 

Whenever you link to a PDF file on a page it is also recommended to include a link to software that can 

read the PDF, such as Acrobat Reader. 

For example: 

Adobe Acrobat is required to view PDF files on this page. If you do not already have this 

application installed you may download Acrobat Reader for free from the Adobe website. 

The underlined text should link to: https://get.adobe.com/reader/ 

Formatting Links to PDFs and Other Non-HTML Resources 

Guideline 3.2.1 On Focus – Level A: When any component receives focus, it does not initiate a change 

of context. 

 Advisory Techniques:  

• G200: Opening new windows and tabs from a link only when necessary 

• G201: Giving users advanced warning when opening a new window 

Open Non-HTML Resources in the Same Tab 

Whenever you link to a PDF or any other non-HTML resource such as Word doc or PowerPoint file, you 

have the option to specify if the file will open in the same tab or a new one. Links to non-HTML resources 

such as PDFs should be set to open in the same tab rather than a new tab or window. Opening a new 

tab or window can be disorienting and frustrating for users. For instance, older screen reading devices 

usually do not announce to the user that a new tab has opened thus rendering the “back” button 

useless. Likewise, those with cognitive impairments may become confused when a new tab 

automatically opens and the “back” button does not allow them to get back to the website. 

  

https://helpx.adobe.com/acrobat/using/creating-accessible-pdfs.html
https://get.adobe.com/reader/
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If the link must open in a new tab or window, it is helpful to add an additional alert to the link text. This is 

not required to meet “Sufficient Techniques” for Level A and AA, but it is listed as an “Advisory 

Technique.”  

For example: Product Specifications (Opens new window) 

In addition, it is helpful, although not required by Level A and AA compliance (only by Level AAA), to 

alert the user of the document type by adding text in parenthesis to the end of the link.  

For example:  Product Specifications (PDF)  

When a PDF or Other File Cannot Be Made Fully Accessible 

Sometimes, the nature of the file’s contents prevents it from being made fully accessible. This is 

especially true where most of the information is conveyed visually and where removing the visual 

information would severely harm usability for sighted users. In these cases, it is advisable to create an 

alternative version of the file that provides the same information in text form. In SiteViz this can be done 

using a static content page. A link can be provided along with the link to the PDF version.  

For example: 

 “Product Specifications: Open as PDF | Open as Text” 

  



 

 

43 • GLOBAL REACH INTERNET PRODUCTIONS, LLC CONFIDENTIAL 

PDF Forms 

For PDF forms, it is recommended to make the fields fillable so that a user with vision problems can use 

their computer to fill it out. 

Examples of Common Accessibility Problems Encountered in PDF Files 

Problem General Solution using Acrobat Pro DC 

Missing XMP metadata stream 

-or- 

Document title must not be blank 

Go to File > Properties  

Add information such as a document title, subject, author and 

keywords. 

Figures must have nonblank alt 

text 

For images that contain important information and are not 

purely decorative do the following: 

 

In the tag navigation pane locate the tag corresponding to the 

image 

Right click on the tag and select Properties 

In the Tags tab fill in the “Alternate Text” field. 

Document not Tagged Go to Accessibility Tools > Autotag Document. 

After the tags have been created use the Reading Order tool 

to verify that the content is organized in a way that will make 

sense to the end user. 

Manually make corrections to the order as needed. 

Missing PDF/UA identifier Go to Tools > Print Production > Preflight 

On the Profiles tab click the Single Fixup icon (the wrench icon). 

Expand the “Document info and Metadata” line 

Scroll down and click the “Set PDF/UA-1 entry” 
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Click the “Fix” button 

Save the file using a new name or the existing name. 

 

Identify the language of the 

page 

Go to File > Properties > Advanced 

Select the language from the menu that best represents the 

language the document is written in. 
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Video Files 

Guideline 1.2.1 Audio-only and Video-only (Prerecorded) – Level A: For prerecorded audio-only and 

prerecorded video-only media, the following are true, except when the audio or video is a media 

alternative for text and is clearly labeled as such:  Hide full description 

• Prerecorded Audio-only: An alternative for time-based media is provided that presents 

equivalent information for prerecorded audio-only content. 

• Prerecorded Video-only: Either an alternative for time-based media or an audio track is 

provided that presents equivalent information for prerecorded video-only content. 

Guideline 1.2.2 Captions (Prerecorded) – Level A: Captions are provided for all prerecorded audio 

content in synchronized media, except when the media is a media alternative for text and is clearly 

labeled as such. 

Guideline 1.2.3 Audio Description or Media Alternative (Prerecorded) – Level A: An alternative for time-

based media or audio description of the prerecorded video content is provided for synchronized 

media, except when the media is a media alternative for text and is clearly labeled as such. 

Guideline 1.2.4 Captions (Live) – Level AA: Captions are provided for all live audio content in 

synchronized media. 

Guideline 1.2.5 Audio Description (Prerecorded) – Level AA: Audio description is provided for all 

prerecorded video content in synchronized media. 

Videos embedded on a page may be inaccessible to the visually impaired, and if the video contains 

audio it will also be inaccessible to people with hearing impairment. For this reason, it is important that a 

caption or transcript accompanies the video. However, if the information conveyed in the video is 

already available as text on the page then no caption or transcript is required. 

If you upload your videos to YouTube, you may use the captioning features of their service. When the 

video is embedded into your website using the “HTML 5” version of YouTube’s player, the caption will be 

available there as well. If captioning is not possible then a link to the text transcript should be provided 

next to the video on the page. 

When adding a YouTube video to your website be sure to fill in the title as shown below. This will assist 

users who can’t see the preview thumbnail in identifying what the video is about before playing it. 
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Audio Files 

Audio files embedded or linked to on a page should be accompanied by a text-based transcript. 

For example: 

 “Listen to our latest broadcast or read the transcript.” 

Flashing Content 

Guideline 2.3.1 Three Flashes or Below Threshold – Level A: Web pages do not contain anything that 

flashes more than three times in any one second period, or the flash is below the general flash and red 

flash thresholds. 

You should avoid the use of animated GIFs and videos that flash 3 times or more per second. The 

flashing may induce seizures in users with photosensitivity. 

Third Party Widgets 

When embedding widgets from third parties first check with the widget's developer to see if it is WCAG 

compliant. If the widget is not compliant consider avoiding it. If the widget must be used then provide a 

text-based alternative for users who are unable to utilize the widget properly. 
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Frames 

Guideline 4.1.2 Name, Role, Value – Level A: For all user interface components (including but not limited 

to: form elements, links and components generated by scripts), the name and role can be 

programmatically determined; states, properties, and values that can be set by the user can be 

programmatically set; and notification of changes to these items is available to user agents, including 

assistive technologies. 

If you need to frame content in from a third-party website, you must ensure that the frame contains a 

title attribute. 

The example below is similar to the frame code that is often provided by third-parties. This example does 

not contain a title attribute: 

<iframe src=”http://www.example.com” name=”exampleframe”></iframe> 

The next example contains a title attribute highlighted in green: 

<iframe src=”http://www.example.com” title=”description of content” 

name=”exampleframe”></iframe> 

SiteViz allows you to add a title to a frame without knowing HTML. 

1. Paste the frame code into the content editor’s “Source” view and then switch back to the editor 

view. 

2. Double Click on the iframe box shown in the content editor. 
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3. Fill in the “Advisory Title” field with a short description of the frame’s contents. 

 

 

 

 

 


